Spartan 6 Decoder Tutorial EES574/ECE3810

Nexys 3 board tutorial
(Decoder, ISE 13.2)
Jim Duckworth, August 2011, WPL

Note: you will need the Xilinx ISE Webpack installed on your computer (or you can use the
department systems).

[Note you can also review Xilinx Tutorials, for example, under Design Resources: ISE Design
Suite Tutorials, and ISE Design Suite Logic Edition - Quick Tour]

Start Xilinx ISE Design Suite,

Select File => New Project or click on New Project

and enter "decoder" for the project name (select an appropriate location):

[ [

&  MNew Project Wizard

Create New Project

Spedfy project location and type.
Enter a name, locations, and comment for the project
Mame: decoder

Location: Cilece574\nexys3\decoder

EE)

Working Directory: | C:\ece574\nexys3\decoder

Description: Decoder Tutorial for Nexys3 board (Spartan & FPGA) using ISE v12_2

Select the type of topJevel source for the project

Topdevel source type:

HDL [=]

) oot )

Click Next and carefully select the family, device, package, etc to match the FPGA on the Nexys
3 board (also select ISim for the simulator):
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@ Mew Project Wizard

[l

Project Settings

Specify device and project properties,
Select the device and design flow for the project

Property Name Value

Product Cateqory All -
Family Spartanb -
pesice T -
Package ?@ -
Speed -2 -
Top-Level Source Type HOL -
Synthesis Tool X5T (VHDL/Verlog) -
Simulator ISim (VHDL/ Verilog) -
Preferred Language YHDL -
Property Specification in Project File | Store all values -
Manual Compile Order

VHDL Source Analysis Standard |VHDL-83 [+
Enable Meszage Filtering [

Next

J [ conce

Click Next, and then click Finish
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r __

_a ISE Project Navigator (0.61xd) - C:\ece574\nexys3\decoder\decoder.xise - [ISE Design Suite InfuCeni_e!

@ File Edit View Project Source Process Tools Window Layout Help BER

IlDBEF L sabx|wa| A, 3R R RS0 ,eirELQ
|| Design ~0e x5 =
view: @ i Simulation (=

eI maen ©

2] | Hierarchy =l P

@ decoder El

| & €3 xcbsbd6-2csg324 E ISE Design Suite 13 Release Overview

g8 i A

o : Empty View , & gt

q = ISE Design Suite Highlights:

& The view currently contains no files.

You (E‘ga’é: T’ES tﬂtﬁ'ap’ﬂlﬁft g > Introducing the 7 Series Device Support
R e TS > Begin designing in Kintex™ -7 and Virex&-7 devices today

2 from the Project menu, and by

= using the Design, Fles, and > Includes Intelligent Clock Gating to reduce dynamic power

m Libraries panels.

» Team Design Flow
Use: > Improved productivity in design, design flow, and
> [EEEP1735 flow for t
*NewSource: Tocreatea
) > Cadence® AXI Bus Function Model (BFI), sold separately, to verify your AXI4 IP
| €2 Mo Processes Running
74, | No single design module is selected. R A
IP Updates: Click here for the IP Release Notes library updates and new products.

S| @3 Design Utilities

24 Resources
& > ISE Design Suite: Release Notes Guide (Including What's New in Xilinx ISE Design Suite Chapter)

> ISE Design Suite: Installation and Licensing Guide
> Known issues in the Xilink ISE Design Suite 13 Release
m, Start ‘ B Design |Wj Files | 1Y Libraries ISE Design Suite InfoCenter a]

Console 08X
Beginning migration of gpst_v300.xise 7
Migration caneelled.

< i, 3

Consale |° Errors |_;}‘ Warnings | 188 Findin Fles Results

Click on New Source (top left icon in the Design window), or menu option Project => New
Source.

Select VHDL Module, and type "decoder" for name:

& Mew Source Wizard

Select Source Type

Select source type, file name and its location,

IP (CORE Generator 8 Architecture Wizard)
Schematic

Uzer Document

Verilog Module

Verileg Test Fixture

VHDL Module Eile name:
VHOL Library decoder
VHDL Package _

VHDL Test Bench Location:

Cilece 574 nexys 3decoder

Add to project

[aee | [ e
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Click Next, and add sw and led port names, select direction, and bus size:

==

@ & New Source Wizard

Define Module

Specify ports for module.
Entity name |decoder

Architecture name | Behavioral

Port Mame Direction L5B =
W in L4
led out

[ Mext H Cancel l

Click Next, and then Finish. A skeleton of your decoder VHDL source file is open for editing:

r
_ ISE Project Navigator (0.61xd) - Cece574\nexys3\decoder\decoder.xise - [decoder.vhd]
File Edit View Project Source Process Tools Window Layout Help E"EE
DAHP L[ XX |(ve| - pLARR RN RE 01 FRIPEL)T |
Deesign +0F Xl 13 -- Dependencies: s
D View: @) @Implemenbhon imulation FET I ——
i h 15 —- Revision: |
‘El IE'EC Y = 16 —— Revision 0.01 - File Created
i decoder - 17 -- Rdditional Comments:
— | B 3 xcbshd6-2csg324 — 15—
4:2:!‘.! ﬂun decoder - Behavioral (decodervhd) 19
= Ll 20 library G
ﬁ e 2l -5TD LOGIC_1164.ALL;
A 22 i
% 23 -- Uncomment the following library declaration if using
E 24 —- arithmetic functions with Signed or Unsigned values
—_ A 25 ——use IEEE.NUMERTIC STD.ALL:
< %% 26
i 27 -—- Uncomment the following library declaration if instantiating
" 'J 28 —— any Xilinx primitivea in this code.
@ 29 --library UNISIM;
— 30 -—-use UNISIM.VComponents.all;
¥ | P2 Mo Processes Running 31
O 32 entity decoder is
1, | Processes: decoder - Behavioral 33 Port { sw : in STD_LOGIC VECTOR (2 downto 0); E
S| ~ L  DesignSummary/Reports 34 led : out S5ID LOGIC VECIOR (7 downto 0)):
e Design Utilities 35 end decoder;
?t User Constraints 36
P [¢] Synthesize - X5T 37 architecture Behavioral of decoder is
- 2  Implement Design 38
P2  Generate Programming File 39  begin
@ Configure Target Device 40
~@&%  Analyze Design Using ChipScope 41
42 end Behavioral;
43
44
4 [T} r
& Start | Er$ Design “E Files | Y Libraries ‘ | ISE Design Suite InfoCenter B E| decoder.vhd [ %] ‘ = Design Summary = I
Console +08x
Started : "Launching ISE Text Editor to edit decoder.vhd".
Launching Design Summary/Report Viewer... D
a | 1 +
Console |T° Errors I_ﬁ Warnings |ﬁ Find in Files Results
Ln15Coll4 VHDL
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Add VHDL statements to describe the operation of the 3 to 8 decoder:

ISE Text Editor (0.61xd) - [decoder.vhd®] | I
File Edit View Window Layout Help [-]=] %]
N =
< 31 A
= 32 entity decoder is
= 33 Port ( sw : in S5TD LOGIC VECTCOR (2 downto 0):
34 led : out STD _LOGIC VECTOR (7 downto 0}}):
35 end decoder;
il 36
37 architecture Behavioral of decoder is
- 38
— 39 begin
A 40
% 41 00000001" when sel = "000" else
42 when sel = else
A 43 when sel = else —
% 44 when sel = else
o 45 when sel = else
[\) 46 when sel = else
.\) 47 when sel = else E
= 48 H
49
S0
51 I
&
P I =T r
decoder.vhd™® B8 |
Insert clipboard contents Ln49 Coll VHDL

In the Processes window (middle-left window of ISE Project Navigator) — double-click on
Synthesize to verify your design.

If successful you should see a green check mark next to the Synthesize operation:

Copyright © 2011 R James Duckworth 5 Rev A



Spartan 6 Decoder Tutorial EES574/ECE3810

. ISE Project Navigator (0.61xd) - Chece574\nexys3\decoder\decoder.xize - [decodervhd]
File Edit View Project Source Process Tools  Window Layout Help
[ & = x, L N o I = - = o
D2Ed & % Xwa| »2PLARARRA BT FRIPTLQ
Design ~O08 X| &&[ 20 --library UNISINM:
[1] | View: @ @Implemenmﬁon (@] Simulaﬁon = 30 --use UNISIM.VComponents.all;
Hierarch =| =
€E| :|erac y 32 entity decoder is
Ei‘é] decoder “ 33 Port ( sw : in STD OR (2 downto 0):
— | = £3 xcbshd6-2csg32d 34 led : out STD_  VECTOR (7 downto 0));:
it ,;"53 decoder - Behavioral (decodervhd) 35 end deecoder:
a 2l =
— e 37 architecture Behavioral of decoder is
A 38
@ % 39 begin
o 40
¥ A 41 led <= "0 0001" when sw = "000" else
% 42 when sw = "001" else T
# | F2 Mo Processes Running e 43 when sw = "010" else
e - @ 44 when sw = "011" else
'?{: P.rocesses: decoder - Behavioral .\:) ag when sw = ™10Q" else‘
E{: L 7] Design Summary/Reports 45 when sw = "101" else
§ Design Utilities 47 when sw = "110" eglse =
o User Constraints 48
- | B @ Synthesize - X5T 49
‘#2  Implement Design 50  end Behavioral:
‘€2  Generate Programming File 51
Configure Target Device 52 E_
wo@% Analyze Design Using ChipScope =
LI =TT 2
|, Start | BN Design |luJ:| Files |lD Librariesl _. ISE Design Suite InfoCenter I:I £ Design Summary {Synthesized) !:! decoder.vhd @
Console +0O8F X
-

. HDL Synthesis ..

(4

Synthesizing Unit <decoder>.

Related source file is "c:/ece574/nexys3/decoder/decoder.vhd".
Found 8x8-bit Read Only RAM for signal <led>
Summary:

inferred 1 RAM(s).

Unit <decoder> synthesized.

HDL Swvnthesis Report =
| T +
Console [o Errors |_ﬁ Warnings Irﬁ Find in Files Results

Ln45Cel38 VHDL
%

Note: in the Console window note that 1 RAM is inferred.
Note: If any syntax errors are listed then fix these in your decoder.vhd source file.

We now need to assign FPGA pins to the switches and leds so they will be connected to the
correct ports on the board. This is done by creating a UCF file (User Constraints File).

Expand the User Constraints process in the Processes window and double-click on the I/O Pin
Planning (Plan Ahead) - Post Synthesis.

Plan Ahead will start and alert you to create a UCF file:
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This process requires that an Implementation Constraint File (UCF) be added to
the project and associated with the selected design module. Would you like
Project Mavigator to automatically create a UCF and add it to the project at this
time?

B ISE Project Navigator

If you select "MNo” you will need to create or add an existing UCF to the project
before running this process.

ves || Mo

LSelect Yes

PlanAhead will now run, eventually a window will open (select the I/O ports tab and then
expand the led and sw ports.

Select led[0] in the I/O ports window and drag to the package pin location U16:
The Site box in the I/O Port Properties window should be updated (instead of dragging, you can
also type the site location directly).

-
E decoder - [C\ece574\nexysIdecoder\planAhead_run_2\decoder.ppr] - PlanAhead 13.2

File Edit Window Layout View Help
Dwox# G 0K @

Netlist Design - decoder.ucf (target) * | x

Tools

1B 1/0 Planning v

o &

| & 3.3

Netiist —Oag x [ Package x Og x @ Device x Oog x
= =
= 7l
- [il] Mram_led21 -
- (i) Mram_led31
[ Mram_led41 |= |
(i) Mram_led51 =
[ Mram_leds 1
- [il] Mram_led71
Mram_led11 e
B+ l=d_0_OBUF (0BUF) =]
£ Sources™, [¥] Netlist | & Timing Constraints (UCF)
Site Properties - OO =
« >[5k
[E uis
acHTian U | o e
. Properties
IjO Ports. — O g =
[‘{. MName Dir Meg Di Site Bank I/OStd Veco  Wref  Drive Strength  SlewType  Pul Type  Off-Chip Termination  IN_TERM  OUT_TERM
= | B+ Allports (11) -
=] = led (8)  Output & L\ICMOSZS 2 5 12 SLOW FP_VTT_50 NONE NONE i
=
& <1 led[1] Output 12 SLOW NONE NONE
?\] <1 led[2] Output LVCMOSZS 2.5 12 sLow FP V'IT 50 NONE NONE
<1 led[3] Output LVCMOS25 2.5 12 sLow FP_VTT_50 NONE NONE
<1 led[4] Output LVCMOs525 2.5 12 5LOW FP_VTT_50 NONE NONE £
<1 led[5] Output LVCMOS25 2.5 12 sLow FP_VTT_50 NONE NONE
< led[6] Output LVCMOs525 2.5 12 5LOW FP_VTT_50 NONE NONE
47 led[7] Output LVCMOS525 2.5 12 5LOW FP_VTT_50 NONE NONE
=3 sw(3) Input LVCMOs525 12 SLOW MNONE NONE NONE
O swl0] Input LVCMOs525 12 sLow MNONE NONE NONE =
O swl1] Input LVCMOs25 12 5LOW MNONE NONE NONE -
Dr sw[2] Input LVCMOs525 12 sLow MNONE NONE NONE =]
Package Pins — 0O o =
C\ MName Prohibit  Port IfOStd  Dir Voo Bank  BankType  BUFIO2Region  Type DiffPair  Clock  Voltage  Config  System Mc
=
Za| B e [OBank 2 (5t ) 2.5 Standard -
= - §3 R15 D 25tandard  BR Multi-function L1P B
E!; D T15 2 Standard BR Multi-function L1M
s uis ---__----
ﬁ) V16 2 Standard BR Multi-function L2M
< m 3 @
5 Td Console | " Messages-, 0 Package Pins
ISE Integration Flow
A
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With reference to the Nexys3 Reference Manual complete the pin information for the rest of the
led and sw ports.

Select File => Save Design and exit PlanAhead.
In the ISE Project Navigator Design - Hierarchy window expand the decoder and you should see

the new decoder.ucf file is now added. To view the UCEF file, select the decoder.ucf and then
select Edit Constraints (Text) in the Processes window and the decoder.ucf file will open:

il |
ISE Text Editor (0.61xd) - [decoder.ucf] EE
Eile Edit View Window Layout Help - |

=H IS
1= 1
b= 2 # Planhhead Generated phyvsical constcraints
f— 3
4 HET "led[0]"™ LOC = Ul&;
5 5 HET "led[l]"™ LOC = V1&;
g HET "led[2]" LOC = Ul5;
7 HET "led[3]" LOC = V15;
o g8 HET "led[4]"™ LOC = M11;
—_— g HET "led[S]"™ LOC = NH11;
A 10 HET "led[&]™ LOC = R11;
o 11 HET "led[7]"™ LOC = T11;
. 12 HET "=zw[O]"™ LOC = T10;
A 13 HNET "s=sw[l]" LOC = T9;
g1 14 HET "sw[2]" LOC = V9;
e ~
¥ |4 r
decoder.ucf x| |
LnlColl UCF
L

Note: You can also just create and edit this UCF file using a text editor (like Notepad or
wordpad).

We can now complete the Synthesis, Implementation, and Generate Programming File steps.

When we generate a programming file we need to specify the FPGA Startup Clock. This will be
set to JTAG for when we load the FPGA through the USB connector using the Adept
Programming Software. When we generate a PROM (FLASH) file then the startup clock should
be set to CCLK.

To set the start-up clock, right-click on the Generate Programming File in the Processes window
and then select Process Properties.
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Select the Startup Options in the Category window and change to JTAG (for loading via USB):

N\

-
Er§ Process Properties - Startup Options

N\

=)

N

Category

N General Options
N \ Configuration Options
Testartup Options
- Readback Optiens
- Encryption Optiens
- Suspend,/Wake Options

Switch Name

-g StartUpClk:
-g DonePipe:
-g DOMNE_cycle:
-g GTS_cycle:
-g GWE_cycle:
-g LCK_cycle:

-g DriveDone:

Property Mame
FPGA Start-Up Clock
Enable Internal Done Pipe
Done (Output Events)
Enable Outputs (Qutput Events)

Release Write Enable (Output Events)
Wait for DUM and PLL Lock (Qutput Events) | Default (NoWait)

Drive Done Pin High

\ Value
(]
Default (4) [=]
Default (5) [~
Default (6) -]
(=]

o

Property display level: |Advanced |z| Display gwitch names
J [ Cancel ] [

[ o aply || Hep |

Back in the design window select the decoder-Behavioral (decoder.vhd) and then double-click
on the Generate Programming File process.

You should eventually see a "Generate Programming File" message in the console window and

green check marks against Synthesis, Implementation, and Generate Programming File

processes:
o 15E Project Navigator (Q.61xd) - C\eceS74\nexys3\decoder\decoder.xise - [decoder.vhd] I
File Edit View Project Source Process Jools Window Layout Help
DRE@ L4 DhXx|wal »ArR 2R RE O ,fRiPELQ
Design «0ax% 30 -—-use UNISIM.VComponents.all: -
) | view: @ @}Implemematon @) 8 simulation » 31
. Hi h - 32 entity decoder is
_rél |Erac y 33 Port ( sw : in CTOR (2 downtao 0);
| decoder - 34 led : out % CTOR (7 downto 0)}):
— | = E3 xcbsbdf-2c59324 35 end decoder;
ﬁ:ﬁ = ﬁ% decoder - Behavioral (decodervhd) 36
T] [ decoderucf o 37 architecture Behavioral of decoder is
=1 —| 28
3 A 39 begin
% 40
# | B2 Mo Processes Running 41 led <= 01" when sw "0o0" else
S " 1 = ng "
'?t Processes: decoder - Behavioral e 22 wjﬂen i & ghae il
- — % 43 when elzse
24 Design Utilities S — 44 when Elae
Eo User Constraints @ 45 when elae
% Creat.e Timing Constraints ) ':;] 46 when else
= I/0 Pin Planning (PlanAhead) - Pre-Synthesis il 47 when slse 3
i I/ Pin Planning (PlanAhead) - Post-Synthesis L a8 100 = T
1 Floorplan Area/I0/Logic (PlanAhead) 3 49
Synthesize - XST 50 end Behavioral:
Implement Design 51
) Generate Programming File 52 L5
Configure Target Device |5 £
Analyze Design Using ChipScope 5 L +
& Start | B3 Design l[]l‘] Files ID Libraries | i Design Summary (Programming File Generated) || : decodervhd  [£] ‘ decoderucf [
Console +0& x
Started : "Generate Programming File".

Running bitgen...
Command Line: bitgen -intstyle ise -f decoder.ut decoder.ncd

Process "Generate Programming File™ completed successfully

1

| T

|
Console I_é Errors |J_\. Warnings |rﬁ Find in Files Results

Ln4l Col42 VHDL
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Select the Design Summary Properties tab in the emain window and you can view the FPGA

device utilization and other results:

—— = =
ISE Project Navigator (0.61xd) - C: L\ jecod - [De S Pr ing File G ted! ﬂ
E roject Navigator (061xc) \eces?: 3\decodendecoderxise - [Design Summary (I rogramming File Generated]]
£ File Edit View Project Source Process Iools Window Layout Help
DEF espbXx/we| 2 BR AR mE0ciseir L9
- 1 =& -
Design oax| @ [z} Design i‘;'::\r/:'wy decoder Project Status (08/37/2011 - 19:32:43) M
@ © B8 ity

[f Ve @ {8 inplementation ©) ff] Smlation o) - ) 108 Properties Project File: decoder.xise Parser Errors: NoErrors

& | Hierarchy [l Module Level Utilization HModule Name: decoder rion State: File Generated

&l ! - decoder [>] - [& Timing Constraints —

11 8 scbsbas-zcsgin — [ Pinout Report Target Device: xcBebc16-2csg324 «Errors: NoErrors

EN & [@% decoder - Behavioral (decodenvhd) [+] - [2] Clock Report Product Version: ISE13.2 *Warnings: No Warnings I

= * [ decoderuct M| ; @ Stafic Timing Design Goak Balanced “Routing Results: Al Signsls Completely Routed

& Errors and Warnings - — . -

BB pamerMessages Design Strategy: Xlinx Default (unlocked «Timing Constraints: =

4 'y - [B) Synthesis Messages Environment: System Settings *Final Timis re: 0 {Timing Report)
@ D 3 Translation Messages
= - [B Map Messages
) - [] Place and Route Messages Device Utilization Sur 5]
[ Timing Messages — - —
- [B) Bitgen Messages Slice Logic Utilization Used Available Utilization Hote(s)
- [B Alllmplementation Messages Number of Slice Registers 0 18,224 0%
Detailed Reports =
No Pr Ru

> €2 No Processes Running "B Synthesis Report Number of Slice LUTs 4 9,112 1%

7. | Processes: decoder - Behavioral - [& Translation Report Number used as logic 4 8,112 1%

9| © Design Summary/Reports - [2] Map Report Number using 06 output orly 0

s Design Utilities i @ Diacsand Houte Report Number using OS output only 0

e Dies Conatraints - [2] Post-PAR Static Timing Report :

= H Create Timing Constraints  [] Power Report Number using 05 and 06 4

1/Q Pin Planning (Plan&head) - Pre-Synthesis . @d E“ERE” R;W‘ Nomber used as ROM 0
1/0 Pin Planning (PlanAhead) - Post-Synthesis ecantaly nepons e 3 o e
[@  Floorplan Ares/I0/Logic (PlanAhead) () WebTalk Log File k4 a
£2€) Synthesize - XsT e Number of occupied Sices 3 2,278 1%
esign Propertics
E) léﬂn‘emf;:ﬂesw & 7] Enable Message Filering Number of LUT Fip Flop pairs used 4
g (E"i'ﬂfﬁ ;"9'::%’“‘”9 1 Optional Design Summary Contents Number with an unused Fiip Flop 4 4 100%
@ oniute Targt eviee, i [] Show Clock Report
@4 Analyze Design Using ChipScope L Show Faig Consteants Number with an unused LUT 0 + 0%
+[[] Show Warnings Number of fully used LUTFF pairs 0 + 0%
“[] Show Errors Number of slice register sites lost 0 18,224 0%
to control set restrictions
Number of bonded [0Bs 1 232 4%
\ Number of LOCed I0Bs 1 11 100%
\ Number of RAMBI6BWERS 0 32 0%
Number of RAMBSBWERS 0 64 0% i

& strt| B3 Design | [ Fies | () Lbrares | £ Design Summary (Programming Fie Generated) a decodervhd <]

Corsole “08x
Running bitgen... -
Command Line: bitgen -intstyle ise -f decoder.ut decoder.ncd
Process "Generate Programming File" completed successfully 3
Started : "Launching ISE Text Editor to edit decoder.vhd".

< i ] »

Console | @ Erors | A\ Warnings [ 18 Findin Fies Results

Some of this information and also from the corresponding Design Overview files will be requried
for your project reports.

You can now close the ISE Project Navigator.

Loading the FPGA

The next step is to transfer the FPGA bit file through the USB cable using the Digilent Adept
software (download from the Digilent website and install).

Connect your Nexys2/3 board to a USB connector on the PC.

Click on the Adept software and the Adept software should recognize the board and show the
FPGA and PROM devices:
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’_5 Digilent Adept I 1 F I.il_‘_ﬂ
NEXYS E i Connect: [Dnbnard 1USB .]
Product: Mexys2 - 500
Config |Flash | Test |Register IO | File IO | 1/0 Ex | Settings |
[ vl Browse. .. Frogram

| nitislize chain |

Board information loaded.

Found device ID: 5046033

Found device ID; 41c22093

Initizlization Complete,
Device 1: XC35500E
Device 2: XCFO45

1 [y

e

(Select Initalize Chain if you do not see the FPGA and PROM devices)

On the FPGA line select Browse and select the decoder.bit file from your project directory

Then select Program.

After programming the DONE led should light on your board and your design should start
running!

You can also load a bit file into the PROM (remember to change the startup clock to CCLK).
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